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Version 8.4 VE - New Features List

The following table lists the new features in 8.4.

Version 8.4 - New Features

Category Feature Name Description

Microsoft - 
Partners

Lync 2013 SVC 
Connectivity to 
Polycom MCU

The Microsoft H.264 SVC codec replaces the H.263 codec previously used 
with Lync 2013 clients. 

Partners - 
Microsoft

Lync 2013 The Collaboration Server can be configuring as a Trusted Application for Lync 
2013.

Licensing New Licensing 
Server

Polycom has introduced a new software licensing procedure for the RMX™ 
800s Virtual Edition. The previous CFS procedure now no longer applies. 

Licensing information is now under Setup in the Main Menu, and not 
under Administration, as in previous versions. 

Audio Audio 
Participant 
Indication icon

The Audio Participant Indication icon displays the number of local audio-only 
endpoints connected to a conference.

Audio G.719 Audio 
Codec

The G.719 Audio Codec is now supported. 

Content Content 
supported at 
HD1080p30 
and 
HD1080p60

Content is supported in both Base and High Profiles.at resolutions of 
HD1080p30 and HD1080p60.

Content Dynamically 
switch from HiP 
to Base and 
vice versa while 
sharing content.

Collaboration Servers 2000, 4000, and Virtual Edition now support 
auto-selection of Base and Hi-Profile while sharing Content.

Conferencing Mute detection 
for Polycom SIP 
endpoints

The Mute icon is displayed in the Participants pane of the RMX Web 
Client/RMX Manager when Polycom endpoints mute themselves.

Microsoft Gateway calls 
to remote SIP 
domain

The RMX’s Gateway functionality can be used to enhance Polycom’s Microsoft 
Solution, enabling the connection of Legacy endpoints to connect to Lync 2010 
endpoints.

Video New video 
layouts

Additional video layouts have been added to the Version 8.4 release.
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Conferencing TP display 
decision matrix

The Room Switch Telepresence layouts normally controlled by the MLA can be 
managed by the MCU to speed updating the conference layouts in large 
conferences with many endpoints.

Conferencing Automatic 
muting of noisy 
endpoints

The RMX can detect AVC endpoints with a noisy audio channel and 
automatically mute them, reducing the noise heard by other conference 
participants.

System Flag Detection of 
H.323 endpoint 
disconnection

On detecting a H.323 endpoint disconnection, a new system flag, 
DETECT_H323_EP_DISCONNECT_TIMER allows you to specify the 
amount of time the MCU waits before disconnecting the endpoint.

Version 8.4 - New Features

Category Feature Name Description
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Version 8.4 VE - Changes to Existing 
Features

The following table lists the changes to existing features in 8.4. 

Version 8.4 - Changes to Existing Features

Category Feature Name Description

Conferencing Recording and 
Network 
Quality icons

The Recording, Recording Paused, and Network Quality icons have been 
redesigned.

SIP Shortening SIP 
Dial-In 
participant site 
names

New system flag: SIP_OMIT_DOMAIN_FROM_PARTY_NAME system flag can 
be used to remove Domain Names from SIP dial-in participants’ Site Names. 
This prevents long domain names being appended to SIP participant names. 

IVR External IVR 
Services 
support via 
MCCF-IVR

The support of External IVR Services via the MCCF-IVR package is enabled by 
default in the Collaboration Server (RMX) systems, by the flag ENABLE_MCCF 
which is set to YES.

However, in Ultra Secure Mode and in secured environments where the External 
IVR Services via the MCCF-IVR package is not required and unused ports 
should be closed, this flag should be set to NO.

To change this flag value from YES to No, you must first add it to the System 
Configuration..

Video Dynamically 
switch from 
HiP to Base 
and vice versa 
while sharing 
content up to 
HD1080p60

The Collaboration Server (RMX) Virtual Edition now supports auto-selection of 
Base and Hi-Profile while sharing Content at resolutions of up to HD1080p60.

Conferencing Room Switch 
Telepresence 
Layout Control

In addition to all other Collaboration Server platforms, Collaboration Servers 
1800, 800s, and Virtual Edition now support Room Switch Telepresence Layout 
Control.

Content H.239 Content 
to Legacy EPs

Support for sending H.239 Content to Legacy endpoints in TIP-enabled 
conferences.

RMX 
Manager

RMX Manager 
multi-user 
capability

You can now make the RMX Manager available to all users on a computer 
during the initial installation. This is done by downloading the RMX Manager 
from the Polycom support website.



 Version 8.4 VE - Changes to Existing Features

Polycom, Inc. 4

Recording Dial In 
Recording Link

Capture Server dial in to Collaboration Server is supported.

Recording System Flag The ENABLE_RECORDING_ OPERATION_VIA_SIPINFO System Flag alllows 
recording control operations to be performed using either DTMF tones or a SIP 
INFO request.

Version 8.4 - Changes to Existing Features

Category Feature Name Description
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Interoperability Table

Devices
The following table lists the devices tested with Version 8.4.

Device
MCU Type

1500/2000/4000 1800 Virtual Editions

Gatekeepers/Proxies 

Polycom CMA 6.2.5 (Gatekeeper) 6.2.5 6.2.5

Polycom Resource Manager 8.2.0_69 8.2.0_69 8.2.0_69

Virtual Resource Manager 8.2.0_50 8.2.0_50

Polycom PathNavigator 7.0.14 7.0.14 7.0.14

Polycom SE200 8.4 8.4

Polycom RMX Gateway 7.7 8.2 8.2

Cisco (Tandberg) Gatekeeper N6.3 N6.3

Cisco (Tandberg) Gateway G3.2

Cisco 3241 Gateway 2.1(1.49)

Radvision ECS gatekeeper 7.7.0.0.27

Radvision Serial Gateway 5.7.2.0.x

Codian 4505 MCU 4.4(3.57)

Lync 2010 server 4.0.7577.225 (CU11) 4.0.7577.225 (CU11) 4.0.7577.225 (CU11)

Lync 2013 server 5.0.8308.577 (CU4) 5.0.8308.577 (CU4) 5.0.8308.577 (CU4)

MS Exchange 2010 14.03.174.001 SP3 
(UR4)

14.03.174.001 SP3 
(UR4)

14.03.174.001 SP3 
(UR4)

MS Exchange 2013 15.00.0775.038 (CU3) 15.00.0775.038 (CU3) 15.00.0775.038 (CU3)

Polycom DMA7000 6.1.0_Build_158329 6.1.0_Build_158329 6.1.0_Build_158329

Virtual DMA 6.1.0_Build_158329 6.1.0_Build_158329 6.1.0_Build_158329

DMA TCSPI DMA TCSPI - 3.2.1 DMA TCSPI - 3.2.1 DMA TCSPI - 3.2.1

Polycom Capture Server 1.6.1-11341 1.6.1.0-11341 1.6.1.0-11341
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BroadWorks AS version 
Rel_20.sp1_1.606

AS version 
Rel_20.sp1_1.606

AS version 
Rel_20.sp1_1.606

ACME SBC ACME Net-Net 
3820 SCX6.4.0 MR-3 
GA (Build 298)

SBC ACME Net-Net 
3820 SCX6.4.0 MR-3 
GA (Build 298)

SBC ACME Net-Net 
3820 SCX6.4.0 MR-3 
GA (Build 298)

RPAD 4.0.0 4.0.0 4.0.0

Recorders 

Polycom RSS 2000 4 4 4

Polycom RSS 4000 8.5.1 8.5.1 8.5.1

Virtual RSS 8.6.0.0-36610 8.6.0.0-36610

MCUs, Call Managers Network Devices and Add ins

Polycom RMX Conferencing 
Add in for Microsoft Outlook 

1.0.x   
Polycom Conferencing 
for Outlook (PCO) 1.4.0

Polycom Conferencing 
for Outlook (PCO) 1.4.0

LifeSize MCU V1.5

BlueJeans MCUV 1.7.0

Radvision Scopia P10 
Gateway

5.7.2.0.25 - -

Redcom LSC Slice 2100 v4.0a (R3P9) v4.0a (R3P9) v4.0a (R3P9)

Avaya Aura Session Manager 6.3.0.8.5682 6.3.0.8.5682 6.3.0.8.5682

Avaya Aura CM R016x.03.0.124.0 R016x.03.0.124.0 R016x.03.0.124.0

Cisco SBC 3.7.3 3.7.3

Cisco CUCM 9.1.2 9.1.2

Cisco CTMS 1.9.3 1.9.3

Cisco TPS 3.0.2-48 3.0.2-48

Cisco VCS X8.1.1 X8.1.1

Crestron Controller 4.001.1012 4.001.1012

Crestron Polycom Build 3.1.2-2 3.1.2-2

Polycom MLA 3.1.2.8 3.1.2.8

Polycom TelePresence Tool 3.1.2 3.1.2

Cisco TelePresence Server 4.0(1.57) 4.0(1.57)

IBM Sametime Server Sametime 9.0.0 version Sametime 9.0.0 version Sametime 9.0.0 version

Device
MCU Type

1500/2000/4000 1800 Virtual Editions
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OpenScape SBC V7R1.12.1 V7R1.12.1 V7R1.12.1

Siemens OSV V7.00.01.ALL.07_PS003
0.E06

V7.00.01.ALL.07_PS003
0.E06

V7.00.01.ALL.07_PS003
0.E06

Endpoints 

Polycom HDX Family 3.1.4-43122 3.1.4-43122 3.1.4-43118

Polycom GS Family 4.1.3_01_ft-190030 4.1.3_01_ft-190030 4.1.3_01_ft-190030

PTC Panel SW 1.10.0-48 1.10.0-48

PTC OS 1.10.0-11 1.10.0-11

Polycom OTX 3.1.3.2 3.1.3.2 --

Polycom RPX 3.1.3.2 3.1.3.2 --

Crestron RPX 3.1.4-1 3.1.4-1

Polycom VSX and V-Series 
Family

9.0.6.2 9.0.6.2 9.0.6.2

Polycom RealPresence 
Desktop

3.2.0.47638 3.2.0.47638 3.2.0.47638

Polycom Viewstation Family 7.5.4 or higher 7.5.4 or higher 7.5.4 or higher

Polycom Viewstation 
FX/EX/4000

6.0.5 or higher 6.0.5 or higher 6.0.5 or higher

Polycom CMA Desktop 5.2.5 5.2.5 5.2.5

Polycom CMA Desktop for 
MAC

5.2.3 5.2.3 5.2.3

Polycom QDX6000 4.0.3 4.0.3 4.0.3

RPM IOS iPhone 3.2-47638 3.2-47638 3.2-47638

RPM IOS iPad 3.2-47638 3.2-47638 3.2-47638

RPM Android Phone 3.2-47638 3.2-47638 3.2-47638

RPM Android Tablet 3.2-47638 3.2-47638 3.2-47638

RPD (PC) 3.2-47638 3.2-47638 3.2-47638

RPD (Mac) 3.2-47638 3.2-47638 3.2-47638

Polycom m100 1.0.6 1.0.6 1.0.6

Polycom VVX1500 5.0.2 5.0.2 5.0.2

Polycom VVX500 5.0.2 5.0.2 5.0.2

Device
MCU Type

1500/2000/4000 1800 Virtual Editions
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Polycom VVX600 5.0.2 5.0.2 5.0.2

Polycom Sound Point 601 SIP 3.1.7 3.1.7 3.1.7

Polycom SoundPoint 650 SIP 4.0.4 4.0.4 4.0.4

Polycom PVX 8.0.16 8.0.16 8.0.16

Polycom iPower 9000 6.2.x 6.2.x 6.2.x

Polycom SoundStation IP4000 
SIP

3.1.7 3.1.7 3.1.7

Polycom SoundStation IP7000 4.0.4 4.0.4 4.0.4

Polycom HDX Touch Controller OS1.9.0-6/TP1.9.0-30 OS1.9.0-6/TP1.9.0-30 OS1.9.0-6/TP1.9.0-30

Polycom Group Series Touch 
Controller

OS4.1.3-73/TP 
4.1.3.01-190025

OS4.1.3-73/TP 
4.1.3.01-190025

OS4.1.3-73/TP 
4.1.3.01-190025

Avaya Voice Phone S3.171b S3.171b S3.171b

Avaya one-X Communicator 6.1.9.04-SP9-132 6.1.9.04-SP9-132 6.1.9.04-SP9-132

Avaya 1000 series endpoint 4.8.3(23) 4.8.3(23) 4.8.3(23)

Avaya Flare Desktop 1.1.3.14 1.1.3.14 1.1.3.14

Avaya ADVD 1_1_2_020002 1_1_2_020002 1_1_2_020002

Avaya Flare Mobile (iOS) 1.1.2 1.1.2 1.1.2

LifeSize Room and Express 4.7.22(3) 4.7.22(3) 4.7.22(3)

LifeSize ICON 600 1.3.2 1.3.2 1.3.2

LifeSize Express 220 4.12.0(30) 4.12.0(30) 4.12.0(30)

LifeSize Team 200 4.7.22(3) 4.7.22(3) 4.7.22(3)

LifeSize Team 220 4.12.0(30) 4.12.0(30) 4.12.0(30)

LifeSize Passport 4.12.0(30) 4.12.0(30) 4.12.0(30)

LifeSize SoftPhone 8.1.12 8.1.12 8.1.12

Cisco (Tandberg) EX90 7.1.1 7.1.1 ----

Cisco (Tandberg) C Series 7.1.1 7.1.1 --

Cisco SX20 7.1.1 7.1.1 --

Cisco CTS3010 
(Telepresence)

1.10.5.1(4) 1.10.5.1(4) ---

Cisco CTS1300 
(Telepresence)

1.10.5.1(4) 1.10.5.1(4) ---

Device
MCU Type

1500/2000/4000 1800 Virtual Editions
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Cisco TX9000 6.1.2.1(5) 6.1.2.1(5) ---

TX 1310 6.1.2.1(5) 6.1.2.1(5)

Cisco CTS500-37 1.10.5.1(4) 1.10.5.1(4)

Cisco CTS500-32  6.1.2.1(5)  6.1.2.1(5)

Jabber iPad 9.3.4 (21626) 9.3.4 (21626) ---

Jabber Video for Telepresence 
(windows)

4.6.3.17194 4.6.3.17194 ---

Radvision SCOPIA XT1000 
endpoint

2.5.416 2.5.416 2.5.416

Radvision Scopia XT5000 8.3.0.61 8.3.0.61 8.3.0.61

Sony PCS –1 3.42 3.42 3.42

Sony PCS –G50 2.72 2.72 2.72

Sony PCS –TL50 2.42 2.42 2.42

Sony PCS-G90 2.42 2.22 2.22

Sony PCS-XG80 2.42 2.42 2.42

Sony PCS-XG100 1.2 1.2 1.2

Tandberg 1700 MXP F9.3.1 F9.3.1 F9.3.1

Tandberg Edge95 MXP F9.3.1 F9.3.1 F9.3.1

Tandberg T150 L6.1 L6.1 L6.1

CSS Server 1.3.0.1009 1.3.0.1009 1.3.0.1009

Addon client 1.3.0.1009 1.3.0.1009 1.3.0.1009

Microsoft Lync 15 client 15.0.4569.1503 15.0.4569.1503 15.0.4569.1503

Microsoft Lync 14 client 4.0.7577.4419 4.0.7577.4419 4.0.7577.4419

Polycom CX7000 1.2.0 1.2.0 1.2.0

Polycom CX500 / CX600 4.0.7577.4420 4.0.7577.4420 4.0.7577.4420

Siemens ODC V7R1.17.0 V7R1.17.0 V7R1.17.0

Siemens OpenStage Desktop 
Voice

V3R1 43 V3R1 43 V3R1 43

IBM-same time Connect client sametime 9 connect 
client - HF1

sametime 9 connect 
client - HF1

sametime 9 connect 
client - HF1

IBM Sametime Lotus client Sametime 9 Sametime 9 Sametime 9

Device
MCU Type

1500/2000/4000 1800 Virtual Editions
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* RealPresence Collaboration Server 800s registration to the CMA Gatekeeper is supported. Bridge 
information (management & monitoring) and scheduling are not supported.

** RealPresence® Resource Manager can schedule calls through the DMA. Reservations are not 
supported. Wave 7 version of RealPresence® Resource Manager (XMA) does not support management, 
monitoring and scheduling of conferences on the Collaboration Server 800s that are directly managed by 
RealPresence® Resource Manager (XMA).

*** Lync 2013 is not supported.

IBM Same time web AV client 
SVC

Sametime 9 Sametime 9 Sametime 9

IBM Same time web AV client 
AVC

Sametime 9 Sametime 9 Sametime 9

Device
MCU Type

1500/2000/4000 1800 Virtual Editions
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Conferencing Options

The following table summarizes the conferencing capabilities and options available in the different 
Conferencing Modes.

Features by Conferencing Mode

Features CP Only Mixed CP & SVC SVC Only

Reservations   

Operator Conferences   

Entry Queues * * *

Dial Out   

Cascading  ** 

IVR   

Reduced IVR set for 
SVC endpoints

Permanent 
Conferences

  

LPR  *** ***

Auto Redial   

Content 

All Content Settings,

All Content Protocols



Graphics Only, H.264 
Cascade & SVC Optimized



Graphics Only, H.264 
Cascade & SVC 
Optimized

Presentation Mode   

Lecture Mode   

Same Layout   

Layout Selection  

AVC endpoints only

Layout set to Auto 
Layout and defined on 
the endpoint

Skins  

AVC endpoints only



Encryption   

Recording  

AVC recording only


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* Entry Queue & Destination Conference must have the same profile (i.e. SVC only to SVC only, Mixed CP 
and SVC to Mixed CP and SVC)

** Only Basic Cascading is available

*** For AVC, the LPR error resiliency is used, for SVC endpoints other error resiliency methods are used. 

Site Names  

AVC endpoints only

Managed by the 
endpoint (not via MCU)

Message Overlay   

Features CP Only Mixed CP & SVC SVC Only
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Resources and Feedback

To find support and to report findings, register on the beta web site and use the following resources:

Polycom Support and Resources

Polycom Support
For support please contact the Polycom Team at 
support@polycom.com

Polycom Test Systems
Go to http://www.polycom.com/videotest for a list of worldwide 
numbers that you can use to test your video conferencing system.

mailto:betasupport@polycom.com
http://support.polycom.com/PolycomService/support/us/support/documentation/video_test_numbers.html 
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RMX Web Client

The following table lists the environments (Web Browsers and Operating Systems) with which the 
Collaboration Server Web Client and RMX Manager applications were tested*. It is not recommended to run 
RMX™ Web Client and Polycom CMAD applications simultaneously on the same workstation.

Collaboration Server (RMX) Wen Client/RMX Manager Environment Interoperability Table

Web Browser Operating System

Internet Explorer 7 Windows Vista™

Windows 7

Internet Explorer 8 Windows 7

Internet Explorer 9 Windows 7 and Windows 8

Internet Explorer 10 Windows 8

If you have problems getting the Collaboration Server Web Client to work with Windows 8, it is 
recommended to run Internet Explorer as an administrator by holding the shift key and right-clicking 
on the IE icon, and then select Run as Administrator.
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Windows 7™ Security Settings
If Windows 7 is installed on the workstation, Protected Mode must be disabled before downloading the 
software to the workstation.

To disable Protected Mode:

1 In the Internet Options dialog box, click the Security tab.

The Security tab is displayed.
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2 Clear the Enable Protected Mode check box for each of the following tabs:

▪ Internet

▪ Local intranet

▪ Trusted sites

3 After successful connection to Collaboration Server (RMX), the Enable Protected Mode check 
boxes can be selected to enable Protected Mode for the following tabs:

 Internet

 Local intranet
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Internet Explorer 8 Configuration
When using Internet Explorer 8 to run the Collaboration Server (RMX) Web Client or RMX Manager 
applications, it is important to configure the browser according to the following procedure.

To configure Internet Explorer 8:

1 Close all browsers running on the workstation.

2 Use the Windows Task Manager to verify that no iexplore.exe processes are running on the 
workstation. If any processes are found, use the End Task button to end them.

3 Open Internet Explorer but do not connect to the MCU.

4 In the Internet Explorer menu bar select Tools >> Internet Options.

The Internet Options dialog box is displayed with General tab open.

5 In the Browsing history section, click the Delete button.

The Delete Browsing History dialog box is displayed.
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6 Select the Temporary Internet files and Cookies check boxes.

7 Click the Delete button.

The Delete Browsing History dialog box closes and the files are deleted.
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8 In the Internet Options dialog box, click the Settings button.

The Temporary Internet Files and History Settings dialog box is displayed.

9 Click the View objects button.

The Downloaded Program Files folder containing the installed Program Files is displayed.
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10 Select the EMAClassLoader.dll file and press the Delete key on the workstation 
or right-click the EMA.ClassLoader.dll file and then click Delete.

11 Close the Downloaded Program Files folder and the Temporary Internet Files and History 
Settings dialog box.

12 In the Internet Options dialog box, click the OK button to save the changes and close the dialog 
box

Upgrade Package Contents
Version Version 8.4 upgrade package must be downloaded from the Polycom Resource Center and 
includes the following items:

● RealPresence Collaboration Server (RMX) 1500/2000/4000 documentation:

 RealPresence Collaboration Server (RMX) 1500/2000/4000 VVersion 8.4 Release Notes

 Polycom RealPresence Collaboration Server (RMX) Getting Started Guide V8.3

 <Italic>Polycom RealPresence Collaboration Server (RMX) 1500/2000/4000 Administrator’s 
Guide V8.3

Where to Get the Latest Product Information

To view the latest Polycom product documentation, visit the Support section of the Polycom website at 
http://support.polycom.com
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Upgrade Procedures

Preparing for the Upgrade
A successful upgrade requires prior preparation. These steps help ensure a smooth upgrade with minimal 
downtime.

To prepare for the upgrade:

1 Download the Version 8.4 software from the Polycom Resource Center web site.

2 Obtain the Version 8.4 Product Activation Key from the Polycom Resource Center web site. For 
more information, see the Polycom RealPresence Collaboration Server (RMX) Getting Started 
Guide, Obtaining the Activation Key .

3 If the RMX is used with a Polycom RealPresence Distributed Media Application (DMA), disable 
RealPresence Distributed Media Application functionality:

a Log into the RealPresence Distributed Media Application that handles call transfers for 
Collaboration Server (RMX).

b Select Network -> MCU -> MCUs.

c Select the MCU and choose either Stop Using or Busy Out.

4 Verify that all conferences, including permanent conferences, have been terminated.

5 Backup the configuration file.

To upgrade from Version 8.3 to 8.4:

1 On the Windows taskbar, click the Start > Programs.

a If the VMware vSphere Client is displayed in the recently used programs list, click VMware 
vSphere Client in the list to start the application.
or

• If Windows7™ is installed on the workstation, Protected Mode must be disabled before 
downloading the Collaboration Server software to the workstation. For more information see 
“Windows 7™ Security Settings” on page 7.

• To maximize conferencing performance, especially in high bit rate call environments, a 1 Gb 
connection is recommended for each LAN connection.

• If the default POLYCOM user is defined in the RMX Web Client, an Active Alarm is created and 
the MCU status changes to MAJOR until a new Administrator user replaces the default user.
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b Select All Programs > VMware > VMware vSphere Client.

The VMware vSphere Client login window is displayed.

2 In the IP address / Name field, enter the IP Address or the name of the vSphere host.

3 Either type your vSphere User Name and Password or select Use Windows sessions 
credentials.
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4 Click Login.

The VMware vSphere Client is displayed.

5 In the Inventory Panel, select the Datastore that houses the MCU.

The inventory of the Datastore appears.
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6 Right-click the MCU virtual machine, then click Power > Shut Down Guest.

When VM turns blue, the virtual machine has shut down.

7 When the MCU has shut down, click the Summary tab.
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8 Under Resources, right-click the datastore, and click Browse Datastore.

The Browse Datastore window appears.
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9 In the Folders tab, select the folder whose name matches that of the MCU.

The contents of the folder are displayed.

10 Right-click the file ending with “.vmx” and click Download.

The Browse For Folder window appears.

If the same name has been used multiple times, there will be multiple folders with an underscore 
and a number appended to the name. In such a case, select the folder with the name of the MCU 
which ends with the highest number.
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11 Browse to a location and click OK.

The Upload/Download Operation Warning window may appear.

12 If the Upload/Download Operation Warning window appears, click Yes.

If it does not appear, proceed to step 13.

The file downloads.
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13 Open the file in any plain text editor.

14 Locate the line that starts with uuid.bios.

15 Copy the entire line and paste it into another text file.

16 Save the text file.

17 In the Inventory Panel, click the Datastore that houses the MCU.

18 Right-click the MCU, and select Delete from Disk.

The Confirm Delete window appears.



 Upgrade Procedures

Polycom, Inc. 29

19 Click Yes.

20 On the vSphere Client menu, select File > Deploy OVF Template.

The Deploy OVF Template wizard opens to the Source page.
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21 Click Browse.

The Open dialog box appears.
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22 Browse to the new OVA file.

23 Either double-click on the OVA file or click on the file, then click Open.
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24 Click Next.

The OVF Template Details page is displayed.
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25 Click Next.

The Name and Location page is displayed.

In the Name field, type the same name previously used for the MCU.

26 Click Next.

The Disk Format page is displayed.
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27 Select Thin Provision, then click Next.

The Network Mapping page is displayed.
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28 Select the appropriate network mappings, then click Next.

The Ready to Complete page is displayed.
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29 Verify that Power on after deployment is not selected.

30 Confirm that all the settings are correct, then click Finish.

The vSphere Client deploys the OVF file.

When the deployment is complete the following window appears:

31 Click Close.

32 In the Inventory Panel, select the Datastore that used to house the MCU.

33 Click the Summary tab.
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34 Under Resources, right-click the datastore, and click Browse Datastore.

The Browse Datastore window appears.

35 In the Folders tab, select the folder whose name matches that of the MCU. The folder name will 
have an underscore and a number at the end. 

The contents of the folder are displayed.
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36 Right-click the file ending with “.vmx” and click Download.

The Browse For Folder window appears.

37 Browse to a location and click OK.

The Upload/Download Operation Warning window may appear.
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38 If the Upload/Download Operation Warning window appears, click Yes. If it does not appear, 
proceed to step 39.

The file downloads.

39 Open the file created in step 15.

40 Open the file in any plain text editor.

41 Locate the line that starts with, uuid.bios.

42 Replace that line with the line saved in the other text file.

43 Add the following as a separate line to the file, including the quotation marks:
uuid.action = “keep”

44 Save and close the file.

45 Optional. To back up the previous configuration:

a In the Datastore Browser window, right-click the .vmx file, then select Rename.

b Change the file extension to “.bak”.
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46 In the tool bar of the Datastore Browser window, click the Upload files to this datastore button.

47 Click Upload File.

The Upload Items window appears.

48 Navigate to where you saved the “.vmx” file in step 44, select it, then click Open.

The Upload/Download Operation Warning window may appear.

49 If the Upload/Download Operation Warning window appears, click Yes.

The file is uploaded.
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50 Close the Datastore Browser.

51 Perform additional configurations as needed. For more information, see the Polycom RealPresence 
Collaboration Server (RMX) Getting Started Guide, 

52 In the Inventory Panel, click the Datastore that houses the MCU.

53 Right-click the MCU virtual machine, then click Power > Power On.

After a few minutes, the MCU turns on.

54 Obtain the IP address of the MCU. For more information, see the Polycom RealPresence 
Collaboration Server (RMX) Getting Started Guide.

55 If the IP address of the MCU is not defined, manually configure the IP settings. For more 
information, see the Polycom RealPresence Collaboration Server (RMX) Getting Started Guide, 
Manual IP Configuration.

56 Start the RMX Web Client application on the workstation.

a In the browser’s address line, enter the IP address of the MCU in the format: http://<Control 
Unit IP Address>. 
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b Click Enter.

The RMX Web Client Login screen is displayed.

57 In the RMX Web Client Login screen, enter the default Username (POLYCOM) and Password 
(POLYCOM) and click Login.

The RMX Web Client opens and the Product Activation dialog box appears with the serial number 
filled in:

58 In the Activation Key field, enter or paste the Product Activation Key obtained earlier and click the 
OK button.

59 Click OK.
A message indicating that the Product Activation Key was loaded successfully appears. 
If the Product Activation Key fails to load, please contact your vendor.

60 Click OK.

If the Product Activation dialog box does not appear, go to Setup --> Product Activation to display 
the dialog box. 
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61 On the RealPresence Collaboration Server (RMX) menu, click Administration > Software 
Management > Restore Configuration. 

62 Browse to the Restore Directory Path where the backed up configuration files are stored and then 
click Restore.

The upgrade to Version 8.4 is complete.

Upgrading the RMX Manager Application
The RMX Manager application can be downloaded from one of the RMX systems installed in your site or 
from Polycom web site at http://www.polycom.com/support. 

To install RMX Manager (downloading the application from the RMX):

1 Start Internet Explorer and connect to the RMX from which the current version was installed.

The Login screen is displayed. 

After the upgrade is complete, all permanent conferences must be manually rescheduled. 

Install the latest version of the RMX Manager (version 8.1 and higher are supported).

• When upgrading the RMX Manager application, it is recommended to backup the MCU list using 
the Export RMX Manager Configuration option. For more details, see <Italic>Polycom 
RealPresence Collaboration Server (RMX) 1500/2000/4000 Administrator’s Guide, Software 
Management .

• When upgrading the RMX Manager from a major version (for example, version 8.0) to a 
maintenance version of that version (for example, 8.0.1), the installation must be performed from 
the same MCU (IP address) from which the major version (for example, version 7.0) was installed. 
If you are upgrading from another MCU (different IP address), you must first uninstall the RMX 
Manager application using Control Panel > Add or Remove Programs.

http://www.polycom.com/support
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2 Click the Install RMX Manager link on the upper right corner of the Login screen.

The installer verifies the application’s requirements on the workstation.

The Install dialog box is displayed.

If the following error message is displayed: “You cannot start application RMX Manager 7.8 from this 
location because it is already installed from a different location” you are upgrading from an MCU that is 
other than the one used for the installed version (different IP address).

In such a case, first uninstall the RMX Manager application using Control Panel > Add or Remove 
Programs.
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3 Click the Install button.

The installation proceeds.

The installation completes, the application loads and the MCUs screen is displayed.

The list includes the previously defined MCUs.

If the MCUs list is empty, import the backed up list using the Import RMX Manager Configuration 
option. For more details, see the <Italic>Polycom RealPresence Collaboration Server (RMX) 
1500/2000/4000 Administrator’s Guide Import/Export RMX Manager Configuration .
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Version 8.4 Detailed Description - New 
Features

Lync 2013 SVC Connectivity to Polycom MCU
The Microsoft H.264 SVC codec replaces the H.263 codec previously used with Lync 2013 clients. Although 
similar Polycom’s standards-based H.264 and SVC implementation, it is proprietary to Microsoft, enabling 
video calls between Lync 2013 clients (endpoints) and Polycom endpoints to be established.

The Collaboration Server considers Lync 2010 and H.264 SVC Lync 2013 clients to be AVC endpoints. The 
administrator must set the Conferencing Mode in the Conference Profile to CP (Continuous Presence) to 
enable H.264 SVC Lync clients to connect to the conference.

Deployment Architectures
Two Deployment Architectures are presented as examples. Both require that a Polycom RealPresence 
Distributed Media Application (DMA) System 7000 be configured as part of the solution.

● Deployment Architecture 1 - Collaboration Server Hosted (Direct)

Lync 2013 clients connect to a conference hosted on Polycom RealPresence Collaboration Server.

● Deployment Architecture 2 - MS AV MCU Cascade

Lync 2013 clients connect to a conference on Microsoft AVMCU which is connected to a Polycom 
RealPresence Collaboration Server.

The following table summarizes current and legacy (non DMA) conferencing modes within the deployment 
architectures:
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Backward compatibility to Lync 2010
All Lync 2013 functionality can be disabled by adding the BLOCK_NEW_LYNC2013_FUNCTIONALITY 
System Flag and setting its value to YES.

The flag’s default value is NO, and when set to yes, all Lync 2013 new functionality is disabled. All Lync 
2013 clients, whether connected Directly or by MS AV MCU cascade, will connect using the RTV codec, not 
the MS SVC codec.

Video Resource Requirements and Implications
Lync 2013 SVC clients may not all connect to a VMR with the same stream layout. They are therefore 
considered H.264 AVC participants and transcoding resources are allocated to them as summarized in the 
following table.

Conference Modes by Deployment Architecture

Conference 
Mode

Deployment Architecture 1

Direct Dial In/Out (No AV 
MCU cascade)
With or without DMA

Deployment Architecture 2

AV MCU Cascade Call (Indirect Dial In)

With DMA
Non DMA

(Backward Compatibility)

AVC Only Supported.

Dial Out out from DMA is not 
supported.

For backward compatibility, 
Dial out from the RMX Web 
Client or RMX Manager can 
be used.
When using backward 
compatibility mode for Dial 
out, H.264 SVC Lync 2013 
clients are not be supported.

If the Video Protocol field in 
the Participant dialog - 
Advanced tab is set to Auto, 
RTV protocol is used.

Supported.

Simulcast transmitted. 
Multiple participants received.

Supported.

One transmitted RTV stream. 
One received RTV stream.

Mixed Mode Supported Not Supported

SVC Only Not Supported
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Support for HD1080p Resolution

The Collaboration Server Hosted deployment supports HD1080p30 video resolution symmetrically for direct 
calls.

The MS AV MCU Cascade deployment supports HD1080p30 video resolution only if Video Optimized mode 
is selected and according to the settings of the LYNC_AVMCU_1080p30_ENCODE _RESOLUTION 
System Flag:

NO (Default) Video streams sent to and received from the MS AV MCU are HD720p30, SD, and CIF.

YES Video streams sent to the MS AV MCU are HD1080p30, SD, CIF. Video streams received from 
the MS AV MCU are 720p30,SD, and CIF.

Limit Maximum Resolution for MS SVC Using a System flag

The MAX_MS_SVC_RESOLUTION System Flag can be used to minimizing the resource usage by 
overriding the default resolution selection and limiting it to a lower resolution. 

Range: AUTO, CIF, VGA, HD720, HD1080

Default: AUTO

The MAX_MS_SVC_RESOLUTION System Flag operates independently from the 
MAX_RTV_RESOLUTION System Flag allowing differing maximum resolutions to be selected for the MS 
SVC and RTV protocols.

Bandwidth and Resource Consumption by Video Codec

Video Codec Resolution and Aspect 
Ratio 

Maximum Video 
Payload Bit rate 
(Kbps)

Minimum Video 
Payload Bit rate 
(Kbps)

Resources

H.264 320x180 (16:9) 
Coded as 320x192 
212x160 (4:3)

250 15 CIF

H.264/RTVideo 424x240 (16:9) 
Coded as 432x240
320x240 (4:3)

350 100 CIF

H.264 480x270 (16:9) 
Coded as 480x272 
424x320 (4:3) 
Coded as 432x320

450 200 SD

H.264/RTVideo 640x360 (16:9) 
Coded as 640:368 
640x480 (4:3)

800 300 SD

H.264 848x480 (16:9) 1500 400 SD

H.264 960x540 (16:9) 
Coded as 960:544

2000 500 SD

H.264/RTV 1280x720 (16:9) 2500 700 HD720p30

H.264 1920x1080 (16:9) 4000 1500 HD1080p30
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If you want to modify System Flag values, the flags must be added to the System Configuration file. For 
more information see: Modifying System Flags  and Controlling Resource Allocations for Lync Clients 
Using RTV Video Protocol in the Collaboration Server (RMX) Administrator’s Guide.

ICE Configuration
The Collaboration Server should be configured with ICE regardless of whether an EDGE Server is part of 
the configuration or not.

Federation Configuration

A secondary SIP domain can be added to the Lync 2013 environment. It must be configured as Federated.

For more information see: Appendix H - Integration Into Microsoft Environments in the Collaboration 
Server (RMX) Administrator’s Guide.

System Flags for Cropping Control
Cropping occurs when the video source (endpoint) aspect ratio is different from the video cell aspect ratio 
in the Polycom Video Layout. 

For all endpoints other than ITP endpoints and panoramic cells the Collaboration Server calculates the 
mismatch percentage between the source video aspect ratio and Polycom video layout cell aspect ratio. The 
mismatch percentage is used to determine whether cropping or striping will be applied to the video cell in 
the Polycom video layout.

For non-panoramic layouts, cropping and striping can be controlled by adding the 
CROPPING_PERCENTAGE_THRESHOLD_GENERAL System Flag and setting its value accordingly.

For panoramic layouts, cropping and striping can be controlled by adding the 
CROPPING_PERCENTAGE_THRESHOLD_PANORAMIC System Flag and setting its value accordingly. 

For both System Flags:

Range: -1-100.

Default: -1

If the calculation result is less than or equal to the value of the 
CROPPING_PERCENTAGE_THRESHOLD_GENERAL System Flag, cropping will be applied. 
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If the calculation result is greater than the value of the 
CROPPING_PERCENTAGE_THRESHOLD_GENERAL System Flag, striping will be applied.

If the CROPPING_PERCENTAGE_THRESHOLD_GENERAL System Flag value is set to 0, cropping will 
not be applied.

If the CROPPING_PERCENTAGE_THRESHOLD_GENERAL System Flag value is set to -1 cropping will 
always be applied.

If the CROPPING_PERCENTAGE_THRESHOLD_GENERAL System Flag value is set to 100, always 
apply cropping with the exception of mobile aspect ratios. Mobile aspect ratios are those with a larger vertial 
aspect than horizontal for example 3:4.

Example: An iPhone Lync client sends 288x352 (3:4) aspect ratio. Cropping this resolution to 16:9 would 
require the cropping of 190 pixels on the vertical aspect. The mismatch calculation would yield 190/352 ~54. 
If the applicable System Flag's value is set to >= 54, striping, rather than cropping, is applied.

For more information see, Modifying System Flags in the Collaboration Server (RMX) Administrator’s Guide.

Sharing Content during a Conference
Using Polycom CSS (Content Sharing Suite) plug in, Lync 2013 clients are able to share content in Polycom 
Content sessions in both Collaboration Server Hosted calls and Cascaded MS AV MCU calls, with both Lync 
2010 & 2013 clients.

Content Sharing behavior is summarized in the following tables:

Content Sharing by Lync Version and Deployment Architecture

Lync Version Collaboration Server Hosted Cascaded MS AV MCU

Lync 2010 Supported, as in previous versions. Not supported

Lync 2013 Supported. Supported

Content Sharing Behavior by Lync Connection and MCU Type

Connection Type Content Sharing Behavior

Point to point: Lync client to 
Lync client.

Microsoft Content is used for the entire session.

Lync calls MS AV MCU 
conference with no 
Collaboration Server cascade 
participant.

Microsoft content is used until Collaboration Server will joins, from which time it 
will switch to Polycom content

Lync calls VMR directly Polycom Content is used for the entire session.
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Collaboration Server joins an 
MS AV MCU conference 
before Content sharing is 
initiated.

Polycom Content is used until Collaboration Server leaves the conference.

Collaboration Server joins an 
MS AV MCU conference while 
Content is being shared.

When the CSS plug in of the Content speaker detects that Microsoft Content is 
being sent by the Lync client, it automatically stops the Microsoft Content and 
switches to Polycom Content and starts sending Polycom Content. 

Polycom Content is used until the Collaboration Server leaves the MS AV MCU 
conference.

CSS Behavior by Lync Content Type

Lync Content Type CSS Behavior

Desktop Sharing Send the desktop In cases where the is more than one monitor, the Lync client asks 
which monitor to use and the CSS will comply.

Program Sharing Only the application is sent.

Power Point Sharing Not supported. CSS should not send the Power Point to the Collaboration Server but 
the Lync clients will be able to send/receive the Power Point. CSS issues a notification 
in the Lync Content presenter device stating that the Power Point cannot be shared 
with non Lync devices.

Whiteboard Sharing Not supported. CSS should not send the whiteboard to the Collaboration Server but the 
Lync clients will be able to send/receive the whiteboard. CSS issues a notification in the 
Lync Content presenter device stating that the whiteboard cannot be shared with non 
Lync devices.

Content Sharing Behavior by Lync Connection and MCU Type

Connection Type Content Sharing Behavior
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Cisco TIP Support
Polycom’s solution that allows the Collaboration Server to natively inter-operate with Cisco TelePresence 
Systems using Cisco TIP protocol is supported.

MLA (Multipoint Layout Application) is required for managing Cisco TelePresence layouts (whether Polycom 
ITP Systems are deployed or not. MLA is a Windows® application that allows conference administrators to 
configure and control video layouts for multipoint calls involving Polycom Immersive Telepresence (ITP) 
systems. For more information see the Polycom® Multipoint Layout Application (MLA) User’s Guide for Use 
with Polycom Telepresence Solutions.

System behavior can be controlled by adding the MS_AV_MCU_ MONITORING System Flag and setting 
its value accordingly as summarized in the following table.

For more information seeCollaboration With Cisco’s Telepresence Interoperability Protocol (TIP) and 
Collaboration with Microsoft and Cisco in the Collaboration Server (RMX) Administrator's Guide.

Lync 2013 Participant monitoring
Lync Clients connected to a conference using the Collaboration Server Hosted architecture will experience 
normal monitoring, with the addition of the MS SVC codec.

Lync Clients connected to a conference using a MS AV MCU Cascade link will be monitored as a single 
participant. In the Conference list the MS AV MCU is listed as Lync AV MCU_x, where x is an incrementing 
number, should multiple be multiple conferences connected using MS AV MCU Cascade links.

For more information see Microsoft RTV Video Protocol Support in CP Conferences in the Collaboration 
Server (RMX) Administrator's Guide.

System Behavior by MS_AV_MCU_MONITORING System Flag Value and MLA Mode

MS_AV_MCU_MONITORING= MLA Mode Collaboration Server Side MS AV MCU Side

MAIN_AND_IN_SLAVE

(Default)

Room Switch Sees the AV MCU current speaker.

Sees the Collaboration 
Server hosted current 
speaker in a 1x1 
layout.

CP Layout
Sees all connected Lync Clients in 
the layout.

NO

(Not recommended)

Room Switch Sees a Lync Client which may or 
may not be the current speaker.CP Layout

 YES 

Room Switch
Sees the MS AV MCU current 
speaker.

CP Layout

(Not 
recommended)

Sees cascaded slave MS AV 
MCUs as empty cells in the layout.
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Monitoring Participant Properties - Channel Status Tab

Two Channel parameters for each MS AV MCU Cascade link are displayed: Video in and Video out.

For both Video in and Video out, the Bit Rate and Packet Loss parameters are displayed as aggregate 
values. For all other Channel parameters (Jitter, Latency, etc.) the highest values ar displayed for each video 
stream.
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Monitoring Participant Properties - Channel Status - Advanced Tab

Media Info of each media stream sent by the MS AV MCU is displayed:

Stream name: The Display Name of the Lync client.

Algorithms: H.264 or RTV.

Resolution: CIF, SD, VGA, HD720 etc.

Frame Rate: 7.5, 15, 30 etc.

Annexes: Used for H.263 only

RTP Statistics are aggregated and are not detailed per stream.

For more information see Participant Level Monitoring in the Collaboration Server (RMX) Administrator’s 
Guide.
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Deployment Architecture 1 - Collaboration Server 
Hosted
Lync 2013 clients connect to a conference hosted on a Polycom Collaboration Server.

● H.264 SVC Lync clients are connected using UCConfig Mode 1: 

 The SVC Codec’s Temporal Scaling capability is used to send one video stream to and from the 
Collaboration Server for each resolution at multiple frame rates.

 H.264 SVC uses H.264 SEI messages to send stream layout information rather than SDP 
messages.

 There is one audio stream per direction.

● Lync clients place calls to a Virtual Meeting Room provisioned on the DMA, for example, 
1234@dma.example.com

● The Collaboration Server can connect Lync 2013 participants to either mixed AVC/SVC or to AVC 
only conferences.

● Lync 2013 clients dialing to a VMR, where the type of the conference is SVC/AVC mixed and AVC 
CP only have their video decoded. The Collaboration Server sends encoded video to Lync 2013 
participants.

Look and Feel
All participants experience a Microsoft Point to Point conference with Polycom video layouts.

Only Classic Skin is supported. For more information about Skins, see Defining AVC-Based Conference 
Profiles in the Collaboration Server (RMX) Administrator’s Guide.
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Deployment Architecture 2 - MS AV MCU Cascade
Cascaded VMR Participants (Lync 2013 clients) connect to a conference on a Microsoft AV MCU which is 
cascaded with a Collaboration Server. 

In this deployment architecture, participants connecting to the conference by way of the Collaboration 
Server are referred to as Cascaded VMR Participants.

● Lync clients place calls to a Virtual Meeting Room provisioned on the DMA, for example, 
1234@dma.example.com

● The Cascaded VMR connects as a Lync client to the AV MCU.

 The Collaboration Server utilizes the SVC Codec’s Temporal Scaling capability to send up to three 
simulcast video streams to the AV MCU, each at multiple frame rates.

 The Collaboration Server receives media from up to five different Lync clients from the AV MCU.

● Lync clients experience a Microsoft Point to Point conference with Cascaded VMR Participants 
appearing as Lync clients.

● Cascaded VMR Participants experience a conference with Polycom video layouts.

● Lync clients will see the active speaker from the 

● Cascaded VMR while Cascaded VMR Participants will see up to 5 Lync clients in addition to other 
participants.
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● Lync 2013 clients, connected by means of the Lync AV MCU, in point to point calls, can connect to 
Collaboration Server VMR participants by escalating the Lync call to a multipoint conference, 
including the Collaboration Server VMR meeting room and its participants.

 The Buddy List can be used to select participants followed by, right-clicking and selecting Start a 
Video Call.

 An ad-hoc (Meet Now) Lync conference can be started; a drag-and-drop operation can then be 
used in the Buddy List to add a Cascaded VMR to the conference.

● Cascaded VMR Participants, in point to point calls, can connect to Lync AV MCU participants by 
escalating the call to a multipoint Lync Conference.

 A re-INVITE is issued to escalate the conference from point-to-point to multipoint.

● A re-INVITE can be issued from an ongoing Audio conference to escalate it, enabling connected 
participants to start sending video.

● Conferences hosted on a Collaboration Server can connect in cascade to only one AV MCU hosted 
conference.

● The Collaboration Server can host multiple conferences, each connected in cascade to a different AV 
MCU hosted conference. Conferences, connected in cascade to an AV MCU hosted conference 
cannot be connected in cascade to other Collaboration Servers.

Look and Feel for Lync clients and Group Series Endpoints
Lync clients and Group Series endpoints with native Lync capability connect to the AV MCU directly and 
experience a Lync look and feel conference and can see all Lync clients; up to 5 simultaneously in Gallery 
View.

If the active speaker is a Cascaded VMR Participant, the participant is seen by Lync Clients in a video 
window in the Gallery View.

By default, Cascaded VMR Participants are forced to a 1x1 layout by the default setting of the 
FORCE_1X1_LAYOUT_ON_CASCADED_LINK_CONNECTION System Flag. The flag’s default setting is 
YES, which prevents a VMR layout being displayed within a Gallery View video window. If required, 
alternative Personal Layouts can be forced only after this System Flag has been added and its value set to 
NO.

For more information see, Modifying System Flags in the Collaboration Server (RMX) Administrator’s Guide.
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Look and Feel for Legacy Endpoints
Legacy endpoints will connect to the Collaboration Server and will be able to see all Lync clients; up to 5 
simultaneously in Polycom video layouts. Only Classic Skin is supported. For more information about Skins, 
see Defining AVC-Based Conference Profiles in the Collaboration Server (RMX) Administrator’s Guide.

Video Resource Requirement Selection in MS AV MCU Cascade

Collaboration Server resource usage in MS AV MCU Cascade can be configured in the conference 
Advanced tab of the Profile dialog by selecting either Resource Optimized or Video Optimized.

Resource Optimized

The Collaboration Server’s Resolution Configuration menu, resolutions of up to HD540p30 (SD30) are 
supported, depending on the conference’s profile setting.

Video Optimized 

The Collaboration Server’s Resolution Configuration menu, resolutions of up to HD720p30 are supported, 
depending on the conference’s profile setting.

If the Collaboration Server has insufficient resources, endpoints will be connected at the lowest resolutions 
possible: CIF or SD. If the Collaboration Server has no available resources, endpoints will not be connected.

Calls that are initially connected as Audio Only will only have video resources allocated to them if they are 
escalated to video calls.
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Video Forcing and Changing Layout in MS AV MCU Cascade

MS AV MCU Cascade behaves in the same manner as Collaboration Server to Collaboration Server 
Cascading.

The Conference Layout as well as the Personal Layouts of participants can be changed. Participants can 
be forced to appear in specific video cells of the layouts.

If Lync 2013 video streams are to be included in a Polycom Conference Layout, the Collaboration Server 
will remove these streams from the layout sent over the AV MCU cascade link.

If Lync 2013 video streams are to be included in a Personal Conference Layout, the Collaboration Server 
will not remove these streams from the layout to be sent over the AV MCU cascade link.

Handle Low Bit Rates Calls From the AV MCU

If the Collaboration Server, or a Group Series endpoint is connected to the AV MCU at a bit rate of 256kbps, 
the AV MCU transmits only one video stream even if it receives multiple video source requests.

At bit rates lower than256kbps (128kbps and 192kbps) the AV MCU does not transmit video.

This limitation can be controlled using the DISABLE_LYNC_AV_MCU_128_AND_192_KBPS System 
Flag. The flag must be manually added to the System Configuration and its value modified as required:

NO (Default)—The Collaboration Server sends 128kbps or 192kbps (according to the call rate) but 
will receive 256kbps for each incoming video stream.

YES—The Collaboration Server will not send or receive video from the Lync AV MCU. The 
connection is audio only.

For more information see, Modifying System Flags in the Collaboration Server (RMX) Administrator’s Guide.

Remove Empty Cells From the Video Layout

Empty cells in the Video Layout can occur as result of the following causes:

Case 1 — A camera connected a PC that is hosting a Lync client is switched off, the cell in which the Lync 
client was displayed remains in the video layout and is empty.

Case 2 — A Lync 2013 Client is connected using a CIF port at a bit rate that exceeds 192kbps.

Case 1

The empty cell can be removed from the video layout by adding the 
REMOVE_EP_FROM_LAYOUT_ON_NO_VIDEO_TIMER System Flag and setting its value as required.

Range: 0 – 19 (seconds): The feature is disabled.

20 – 300 (seconds): The feature is enabled.

Default: 20

When enabled (flag value 20 - 300), the endpoint is removed when the empty cell is detected, and the cell 
is used for another participant if:

● No video RTP messages are received from the EP for the defined timer value in addition to one of 
the following timers, depending on the call type:

 DETECT_SIP_EP_DISCONNECT_TIMER

 DETECT_H323_EP_DISCONNECT_TIMER
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● Either the PRESERVE_PARTY_CELL_ON_FORCE_LAYOUT System Flag =NO 

or 

The endpoint is not forced in the layout.

Case 2

The RTV_MAX_BIT_RATE_FOR_FORCE_CIF_PARTICIPANT System Flag has been added to the 
system with a default value of 192 (kbps). This ensures that the Lync Client sends the correct resolution and 
that its cell in the Video Layout is displayed correctly

In Lync environments that do not include ICE, the empty cell will remain in the layout for direct Lync 
calls.



 Version 8.4 Detailed Description - New Features

Polycom, Inc. 61

New Licensing Server
Polycom has introduced a new software licensing procedure for the RMX™ Virtual Edition. The previous 
CFS licensing procedure no longer applies.

Licensing Modes
The new licensing procedure consists of two modes:

● Standalone Mode

In Standalone mode, the number of resources is determined by the capacity of your machine, 
including the number of ports.

● Solution Mode (RPP)

In RPP mode, the number of resources is determined by the license agreement.

Activating the Licensing Agreement

Before you begin to use the RealPresence Collaboration Server Virtual Edition, you need to activate the 
Licensing Agreement. 

This guide assumes that you have downloaded and installed the RealPresence Collaboration Server 
RCPS Virtual Edition.

For more information, see RealPresence Collaboration Server RCPS Virtual Edition, Getting Started 
Guide, First Time Installation and Configuration for the RealPresence Collaboration 
Server Virtual Edition.

The Licensing Information tab is now under Setup in the Main Menu, and not under 
Administration, as in previous versions. 
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To activate your Licensing Agreement:

1 On the Collaboration Server menu, click Setup > Licensing. 

2 Click Product Activation to display the Product Activation dialog.

3 Enter the IP address of the Primary Licensing Server. All other fields are populated by default.

Product Activation Parameters

Field/Option Description

Serial Number The serial number is the Universal Unique Identifier (UUID). By default, it is 
automatically loaded into the Serial Number field on installation.

Primary License Server Enter the IP address of the Licensing Server * 
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4 Click OK. An activitation request is sent to the Licensing Server.

Active Alarms
In the event of any failure in the licensing procedure, an Active Alarm is displayed in the Collaboration 
Server System Alerts pane.

In the event that no valid license is found, or the license agreement has expired, the MCU responds as 
follows:

● All resources are blocked and new calls cannot be created (dial-in or dial-out).

● Current calls continue.

● New ongoing conferences cannot be created.

● New meeting rooms and gateway profiles can be created, but cannot be activated.

Port The number of the communication port between the MCU and the Licensing 
Server. 

The default port number is 3333 (HTTPS, secured). The number is 
configurable.

*The Licensing Server is the Polycom local license server. It enables you to securely acquire the licences for 
the products you have purchased.  

Active Alarms

Alarm Code Alarm Description

Insufficient resources In Standalone (a La Carte) mode, when the number of ports you attempt 
to use exceeds the number contained in the License Agreement.

License was modified Modified license includes change in capabilities

The modified license will take effect after system restart

Valid license not found * This alarm may be triggered for the following reasons:

• No accessible license on system startup.

• Licensing Server is not accessible at this time.

• Borrow date (product expiration date) has been reached.

* If no valid license is found, the MCU attempts to contact the Licensing Server at 1 minute intervals (or according 
to the interval defined in the LICENSE_VALIDATION_INTERVAL system flag. 

Product Activation Parameters

Field/Option Description
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Viewing Licensing Properties and Capabilities
Follow the procedure below to view your current licensing properties and capabilities. 

To view licensing properties and capabilities: 

1 On the Collaboration Server menu, click Setup > Licensing. 

For more infomation, see the Polycom® RealPresence Collaboration Server 800s/Virtual 
Edition Administrator’s Guide, Appendix B - Active Alarms .
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2 Click License Information to display the License Infomation window.

Licensing Properties Parameters

Field Description

License Server The name or IP address of the Licensing Server

Borrow Licence Expiration 
Date

The date on which the product expires. The borrow expiration date is 
updated each time the MCU refreshes the license

Refresh License Pressing this button manually refreshes the license details

License Capabilities This section displays the capabilities you are licensed to use 

Capabilities refer to the particular feature or resource capacity you are 
entitled to use according to the license agreement
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Setting the Time Interval for License Validation and Updates
The MCU automatically checks for license validity and updates. The default flag value is set to 1 minute. 
However, this can be modified to anything between 1‐60 minutes by setting the 
LICENSE_VALIDATION_INTERVAL system flag. 

For more infomation, see the Polycom® RealPresence Collaboration Server 800s/Virtual Edition 
Administrator’s Guide, System Configuration Flags .

Polycom Partners Lists licensed Polycom partners 

* The Borrow License Expiration Date is whatever date is reached after seven days from the failure to 
connect to the Licensing Server. The MCU will continue to function up to the expiration date. 

When the expiry date is reached, an Active Alarm displays in the System Alerts pane.

Licensing Properties Parameters

Field Description
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Audio-Only Indication Participant Icon
During an ongoing conference, Audio Participants Indication icon provides an indication to all participants 

that audio-only endpoints and secondary video devices are connected to the conference.

 

The Audio Participant indication icon is displayed in the conference video screen along with the number of 

audio-only or secondary endpoints connected. These icons are displayed as part of a group that includes a 

network quality indication and a recording indication displayed when recording is active. The icon group is 

displayed for AVC endpoints only.

The following figure shows that 97 audio participants are connected to the current conference.

The following conferencing modes are supported:

● AVC-CP (Continuous Presence)

● CP and SVC (Mixed Mode). 

● Up to 99 audio participants can be indicated; when more than 99 participants are in the conference, 
the indicator shows 99+.

● You can set audio participant indication to display permanently or for a short period only when the 
number of audio participants changes. When audio participant indication is set to display 
permanently, it is displayed only when audio participants are connected to the conference.

Audio participant indication is not supported in the following circumstances:

● In TIP-enabled conferences

● In SVC only and AVC-VSW (Video Switched) conferencing modes

● For remote audio participants in cascading conferences; only the number of audio participants 
connected to the local MCU is displayed

● On SVC endpoints

● During the gathering phase of a conference

● At video resolutions lower than 4CIF
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Choosing the Display Position of the Indication Icons
The display, position, and duration of the indication icons are configured in the Layout Indications tab of the 
conference Profile dialog, shown next. 

Choose Indication Icons to Enable for Display

To enable indication icons, select the Recording, Audio Participants, and Network Quality check boxes in 

the Layout Indications tab of the conference Profile dialog.

The Recording indication icon is a duplicate of the Display Recording Icon field in the Recording tab 
of the Profile dialog. For more information, see Recording Conferences in the Collaboration Server 
(RMX) Administrator’s Guide.
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Indication Icon Display Positions 

Use the Position drop-down menu to configure the display position of the indication icons group. Icons can 
be displayed in the following positions in the video layout:

Following are examples of the indication icon display positions.

Top-center (default) with all indication icons enabled

Top-left, with all indication icons enabled

Top-left, with all indication icons enabled, recording enabled but not active

· Top-left · Bottom-left
· Top center (default) · Bottom
· Top-right · Bottom-right
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Top-left, audio participants, network quality enabled, recording not enabled

Top-right with all indication icons enabled, recording active
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Gateway Calls to Remote SIP Domain
The RMX’s Gateway functionality has been enhanced, enabling the connection of H.323 and SIP endpoints 
to SIP endpoints residing in a remote domain, different to that of the MCU’s domain.

Guidelines
● The calling endpoint may be H.323 or SIP.

● The destination endpoint must be SIP.

Calling a SIP Endpoint in a Remote Domain
The dial string from the calling endpoint to the RMX includes the gateway dial-out number of the SIP 
endpoint that is located in the remote domain.

By definition, a dial-in string cannot contain two domains and it is therefore necessary that the dial string be 
of the following format:

mcu-meeting-room*dest%40dest-domain@mcu-domain

Where:

● The domain of the gateway call is mcu-domain

● The remote destination domain is dest%40dest-domain.

● The “%40” is replaced with an “@” when the gateway call is dialed to the remote SIP destination.

Limitation
● DTMF tones and Caller-id are not passed end-to-end.

In order to support RTV, the SIP Server Type must be defined as Microsoft.
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New Video Layouts
The following Video Layouts have been included in this version.

Selecting the Video Layouts

For conferences, the layouts can be selected by clicking the  and  icons in the 9 and 10+ Video 
Layout groups of the New Profile / Profile Properties - Video Settings tab.

For participants, the layouts can be selected as Personal Layouts in the same manner as for conferences, 
using the Participant Properties - Media Sources tab.

TelePresence Display Matrix
How the speaker video is displayed on the screens of the conference participants is dependent on the 
relationship between the number of screens the speaker endpoint contains and the number of screens of 
the endpoints of the other conference participants. 
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The following Telepresence Display Decision Matrix table below indicates how the speaker video will be 
displayed on the various participant endpoints, when the MCU is managing Telepresence Room Switch 
conference layouts.

For example, if the speaker’s endpoints has two screens and the participant’s endpoint only one, the 
participant’s display is divided into two video layout cells with each video layout cell showing the input of one 
of the speaker’s screens (endpoint). 

If the participant endpoint has two screens, and the speaker endpoint only one, the speaker’s video will be 
displayed on one of the participant’s screens, while the second screen remains black.
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Version 8.4 VE Detailed Description - 
Changes to Existing Features

Changes to User Interface and Layout Indication Icons
For improved ease of use and real-time status indication, the user interface (RMX Web Client and RMX 
Manager) and layout indication icons have been modified.

Changes to the User Interface
A new tab, Layout Indications, has been added to the conference Profile dialog. The display characteristics 
of the indication icons are configured using this tab. The Layout Indications tab is displayed only if AVC-CP 
or AVC-CP and SVC (mixed mode) is selected.

For more information, see Choosing the Display Position of the Indication Icons .

Changes to System Flags

The configuration options of the Layout Indications tab have replaced the following system flags, which are 

no longer used:

● DISABLE_SELF_NETWORK_IND

● SELF_IND_LOCATION

The Recording Indication icon is a duplicate of the Display Recording icon of the Recording tab of the 
Profile dialog. For more information, see Recording Conferences.
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Changes to Existing Indication Icons

The appearance of the following indication icons have been modified.

New Audio Participant Indication

During an ongoing conference, the Audio Participant indication icon provides an indication to all 

participants that are audio-only endpoints and video devices connected as secondary are connected to the 

conference.

 

The Audio Participant indication icon is displayed in the conference video layout along with the number of 

audio only or secondary endpoints connected, where more than 99 such participants are displayed as 

“99+”.

Modified Indication Icons

New Old Description

Recording

For more information, see RealPresence Collaboration Server (RMX) Administrator’s Guide, 
Recording Conferences.

Recording Paused

For more information, see RealPresence Collaboration Server (RMX) Administrator’s Guide, 
Recording Conferences.

Network Quality Major

For more information, see RealPresence Collaboration Server (RMX) Administrator’s Guide, 
Layout Indications (AVC Endpoints) . 

Network Quality Critical

For more information, see RealPresence Collaboration Server (RMX) Administrator’s Guide, 
Layout Indications (AVC Endpoints) . 
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Shortening Site Name Display
The SIP_OMIT_DOMAIN_FROM_PARTY_NAME System Flag can be used to remove Domain Names 
from SIP dial-in participants’ Site Names. This prevents long domain names being appended to SIP 
participant names, as frequently happens when the Collaboration Server (RMX) is used with a DMA. 

The flag must be manually added to the System Configuration and its value modified as follows:

● YES (Default) - The domain name is omitted from SIP dial-in participant names.

● NO - The domain name remains as part of SIP dial-in participant names.

For more information see Modifying System Flags in the Collaboration Server (RMX) Administrator’s Guide.
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RMX Manager Multi-User Capability
The RMX Manager can be installed to be available to all users of a shared computer during the initial 
installation.

The following procedure is performed after downloading the RMX Manager from the Polycom Support 
website.

To install the RMX Manager for Multiple Users:

1 Download the RMX Manager installation package from the Polycom Support website.

2 Unzip the installation package.

3 Double-click setup.exe to open the RMX Manager Setup Wizard.

The RMX Manager can still be installed from the Collaboration Server (RMX) Web Client, but the 
installation will only be available to the current user.
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4 Click Next.

5 Select Everyone to install the RMX Manager for all users sharing the computer. 

(Select Just me to install the RMX Manager just for the current user.)

6 Click Next.
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The installation begins.

When the installation is complete, a confirmation window is displayed.

7 Click Close to close the RMX Manager installer.

The installation is complete.
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RSS/Capture Server Dial In Recording Link
Conferences running on the Collaboration Server can be recorded using Polycom RealPresence® Capture 
Server in the following ways:

● Capture Server dials in MCU for conference recording via an SIP interface from Capture Server. From 
the Capture Server Admin UI, you can start a conference recording by dialing out to a Collaboration 
Server. After the Collaboration Server gets the request from the Capture Server, the recording will 
start if the recording is enabled on the Collaboration Server. During the conference recording, you 
can pause or stop the recording from the Capture Server Admin UI. Refer to the Polycom 
RealPresence Capture Server User’s Guide on how to start a recording by dialing out to an 
interoperable endpoint.

● Collaboration Server dials out to Capture Server for a conference recording. Recording conferences 
is enabled via a dial-out Recording Link, which is a dial-out connection from the conference to the 
recording system.

Changes to the User Interface
In the Recording tab of the New Profile dialogue, the Recording field has been renamed Dial Out 
Recording Link.

A new check box, Play Recording Message, has been added. It is checked by default and a message is 
played to all participants announcing that the conference is being recorded.

Un check the Play Recording Message check box to prevent the announcement from being played.

New System Flag for Recording Control Operations
The user can start, stop, pause recording during a conference. In previous versions, recording control could 
be performed using DTMF tones. This version gives the user the option of performing recording control 
operations using either DTMF tones or using a SIP INFO request.

The ENABLE_RECORDING_OPERATION_VIA_SIPINFO System Flag can be added and its value set as 
required.
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NO: The Collaboration Server will send Recording Control Operation commands to the Capture Server 
using DTMF as in all previous version.

YES: The Collaboration Server will send Recording Control Operation commands to the Capture Server 
using a SIP INFO request.
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Version 8.4 VE Corrections and Known 
Limitations

Corrections Between Version 8.3 and Version 8.4

Realpresence Collaboration Server Virtual Edition V8.4 - Corrections

Issue ID Category Description
Found in 
Version

BRIDGE-
8039

General In an ICE enabled environment, when dialing out from a conference 
without encryption to CX500 or CX600 endpoints, the call is 
disconnected within a few seconds. 

V8.2

BRIDGE-
11410

General In a mixed AVC-SVC 1920 kbps conference set to encrypt when 
possible with 15 HD AVC dial-in participants connecting using H.323 
and 15 HD SVC dial-in participants connecting using SIP, after 12 
hours 1 AVC participant was disconnected, the other endpoints were 
muted, and 1 RealPresense Desktop endpoint using H.323 
connected, resulting in 100% packet loss, very poor video and 
audio, and a low bit rate. 

V8.3

BRIDGE-
11090

Video In a mixed AVC-SVC 1920 kbps conference with a welcome 
message and welcome slides for both IVR and entry queue services, 
when the endpoints are moved from the entry queue to the main 
conference and a RealPresense Desktop client connects using SIP 
at 1920 kbps, the layout on the RealPresence Desktop client is 
sometimes 1:1 and sometimes 1+8. 

V8.3

BRIDGE-
10684

Interoperability In a 1920 kbps encrypted conference, a RadVision XT5000 using 
SIP over TLS disconnected after a few seconds. 

V8.3

BRIDGE-
10439

Resource 
Capacity

In a 2 mbps AVC only conference with a Group Series endpoint 
connecting using H.323 at 1080p30 resolutionm if 22 AVC 
participants dial in, bringing the system over capacity, some 
participants disconnect while others get stuck on "waiting for dial-in" 
status. 

V8.3, 
V8.3.1
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Known Limitations

Realpresence Collaboration Server Virtual Edition V8.4 - Known Limitations

Issue ID Category Description
Detected 
in 
Version

Workaround

BRIDGE-
12047

Content On RPCS VE, some bad pixels may appear on Cisco 
telepresence endpoints connected to a conference 
running in TIP Video + Content mode,

V8.4 Use the 
preferred TIP 
mode

BRIDGE-
12479

Partners - 
Microsoft

On RMX systems with MPMRx blades cascaded to Lync 
2013 AVMCU, video freeze may occur on Lync clients 
connected directly to the RMX, if Lync 2010 and Lync 
2013 clients are connected simultaneously to the 
AVMCU. Video resumes after a short period.

V8.4 If the video 
freezes, 
disconnect 
from the call 
and call back 
in.

BRIDGE-
12663

SIP Hot backup: SIP participants cannot reconnect after 
switch over between master and slave RMXs.

V8.4

BRIDGE-
13342

Interopera
bility

On Collaboration Server VE, Content is not seen on Cisco 
H.323 endpoints registered with CUCM when working in 
TIP Video + Content Mode.

V8.4 Use “Prefer 
TIP mode”

BRIDGE-
13470

SIP RMX dial-out fails when SIP device authentication is 
enabled in DMA.

V8.4

BRIDGE-
13499

Partners - 
Microsoft

Lync mobility client will not connect in a dial out scenario. V8.4

BRIDGE-
13518

Interopera
bility

When using specific versions of Group Series endpoints, 
connecting as SVC to a Mixed Mode (SVC/AVC) 
conference, the Group Series endpoint will, rarely, not see 
the AVC endpoints.

V8.4 Upgrade the 
Group Series 
endpoints.

BRIDGE-
13591

Interopera
bility

Sony PCS-XG80 and XG-100 endpoints do not receive 
content while in a Collaboration Server (RMX) 1800 or VE 
call. 

V8.4

BRIDGE-
13620

Interopera
bility

When placing a call from ISDN to DMA VMR via S4GW 
and RMX Gateway which translates from H.323 to SIP, 
calls may not connect the first time.

V8.4

BRIDGE-
13622

Partners - 
Microsoft

Lync registered Edge endpoints have packet loss and 
poor video during RMX conference. Hold and resume 
intensifies the poor video performance.

V8.4

BRIDGE-
13634

Interopera
bility

In a Siemens environment, VVX fails to connect in a dial 
out scenario.

V8.4
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BRIDGE-
10808

Interopera
bility

When an HDX 8000 registered to a SIP server connected 
to an MCU registered to a DMA 7000 attempt to connect 
to a mixed AVC-SVC 1920 kbps conference using a line 
rate of 64 kbps, instead of connecting as audio only the 
connection failed.

V8.3, 
V8.3.1

BRIDGE-
10140

Video VSX receives no video in SIP call registered to DMA. V8.3

BRIDGE-
7341

General Error message displays before successfully logging into 
the VMCU via the console: 
"user/Plcm-Utils/Scripts/SetupMenu.sh: line32: : No such 
file or directory".

V8.2

BRIDGE-
8004

SIP SIP endpoints may intermittently disconnect after a 
conference has run for more than 30 minutes.

V8.2

BRIDGE-
8033

IVR RealPresence Mobile, RealPresence Desktop, and Group 
Series endpoints do not hear roll call messages when 
dialing into an SVC conference.

V8.2

BRIDGE-
8132

Content Content cannot be shared when dialing-out from a CP 
only conference with content set to H.263 & H.264 to 
Tandberg Edge95 (MXP) endpoints over H.323.

V8.2

BRIDGE-
6587

IVR In the IVR Service after rebooting an RMX800s, the 
“enable welcome message” check box becomes 
unchecked and the welcome audio message is not 
played.

V8.1.7

BRIDGE-
7307

Video In a conference with 1 OTX and 2 TPX's with the OTX 
and 1 TPX connecting using ITP conference room 
switching, after applying MLA automatic layout, a black 
bar is displayed on the central monitor of the OTX.

V8.1

BRIDGE-
2340

IP Failure to remove first IP address on a list of NT server 
addresses.

V8.0

BRIDGE-
1045

General On the Real Presence Collaboration Server 800s, when 
changing the duration of conference, there is no message 
dialog box to prompting you to click OK.

V7.8.0

BRIDGE-
1156

RMX 
Manager

"Insufficient resource" alarm displays after executing 
"service soft_mcu restart" and then logging in via the 
RMX Manager.

V7.8.0

BRIDGE-
1333

Interopera
bility

On the Real Presence Collaboration Server 800s, after a 
second SIP RPD audio only endpoints joins, only one 
Audio Rx is shows is listed in RPD statics when there 
should be two.

V7.8.0

Realpresence Collaboration Server Virtual Edition V8.4 - Known Limitations

Issue ID Category Description
Detected 
in 
Version

Workaround
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BRIDGE-
1441

General Automatic reboot fails after modifying system flags even 
though system prompts reset.

V7.8.0

BRIDGE-
993

General During a conference started from a Profile, after an SVC 
RPD participant dials-in, the Participants Properties - SDP 
tab, Remote Capabilities pane lists no information.

V7.8.0

BRIDGE-
5921

Video Layout pictures display incorrectly when more than 15 
participants join the conference.

V7.2.2

BRIDGE-
13629

Content On a call set to TIP Video & Content mode some H.323 
endpoints may not receive content.

Use “Prefer 
TIP mode”

Realpresence Collaboration Server Virtual Edition V8.4 - Known Limitations

Issue ID Category Description
Detected 
in 
Version

Workaround
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Troubleshooting Instructions

Collaboration Server Web Client Installation - 
Troubleshooting Instructions

If a Browser Environment Error occurs, close all the Internet Explorer sessions and reconnect to the MCU.

If the problem persists, you can run the Automatic Troubleshooting Utility or perform the 
Troubleshooting Procedures manually.

The Manual Troubleshooting Procedures include several procedures that can be performed in order to 
solve the connection error. At the end of each procedure, check if you can connect to the MCU and if the 
problem persists, perform the next procedure.

The following troubleshooting procedures can be performed manually: 

● Procedure 1: Ending all Internet Explorer Sessions

Use of the RMX Web Client is not recommended in Maximum Security 
Environments.Management using the RMX Manager is the recommended method.

In Secured Mode (https://), the DNS name specified in the RMX’s Certificate must correspond with 
that of the DNS Server used by the Client that is connecting to the RMX
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● Procedure 2: Deleting the Temporary Internet Files, Collaboration Server Cookie and Collaboration 
Server Object

● Procedure 3: Managing Add-ons Collisions

● Procedure 4: Add the Collaboration Server to the Internet Explorer Trusted Sites List

● Procedure 5: Browser Hosting Controls (Optional) 

Procedure 1: Ending all Internet Explorer Sessions

In some cases, although all the Internet Explorer sessions were closed, the system did not end one or 
several IE processes. These processes must be ended manually. 

To end all Internet Explorer sessions:

Start the Task Manager and click the Processes tab.

1 Select an iexplore process and click the End Process button.

2 Repeat this process for all iexplore processes that are currently active.

3 Close the Windows Task Manager dialog box.

4 Open the Internet Explorer and connect to the MCU.

5 If the problem persists, continue with Procedure 2. 

Procedure 2: Deleting the Temporary Internet Files, RMX Cookie and RMX Object

If at the end of Procedure 1 the error message is still displayed, and you cannot connect to the MCU, 
perform the following operations:

● Delete the Temporary Internet files

● Delete the RMX/Collaboration Server Cookie

● Delete the RMX/RMX ActiveX Object
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Deleting the Temporary Internet Files

To delete the Temporary files:

1 In the Internet Explorer, click Tools > Internet Options.
The Internet Options dialog box opens.

2 In the Browsing history pane, click the Delete button.

The Delete Browsing History dialog box opens.
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3 It is recommended to delete only the Temporary Internet files. 
By default, the Cookies option is also selected. Clear it if you do not want to clear the cookies from 
your computer.

4 Click the Delete button.

5 When the process is complete, the system return to the Internet Options dialog box.
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Deleting the RMX/Collaboration Server Cookie

To delete the RMX Cookie:

1 In the Internet Options dialog box - Browsing History pane, click the Settings button.

The Temporary Internet Files and History Settings dialog box is displayed.
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2 Click the View files button.

The Windows Explorer screen opens, listing Windows Temporary Internet Files.

3 Browse to the RMX/ RMX cookie. 
The cookie is listed in the format: cookie:user name@RMX/RMX IP address. For example: 
cookie:valerie@172.22.189.110.

4 Right-click the RMX cookie and click Delete.

The system prompts for confirmation.

5 Click Yes.
The cookie is deleted.

6 Close the Windows Explorer screen.
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Deleting the RMX/Collaboration Server ActiveX Object

To delete the RMX/RMX ActiveX Object:

1 In the Temporary Internet Files and History Settings dialog box, click the View objects button.

The Windows Explorer screen opens, listing the Windows Downloaded Program Files.

2 Right-click the EMA.ClassLoader.dll and then click Delete.

The system prompts for confirmation.

3 Click Yes.
The RMX object is deleted.
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4 Close the Windows Explorer screen.

5 In the Temporary Internet Files and History Settings dialog box, click OK.

6 In the Internet Options dialog box, click OK to close it.

7 Close the Internet Explorer session and reopen it.

8 Connect to the RMX.

If the problem persists, continue with Procedure 3. 

Procedure 3: Managing Add-ons Collisions

In some cases, previously installed add-ons, such as anti virus programs can create collisions between 
applications and prevent the installation of a new add on. Disabling these add-ons may be required in order 
to install the RMX Web Client.

To disable an add-on:

1 In the Internet Explorer, click Tools > Manage Add-ons.
The Manage Add-ons - Toolbars and Extensions dialog box opens.

2 Scroll to the add-on to disable (for example, the anti virus add-on), right-click it and then click 
Disable.

Alternatively, select the add-on and click the Disable button.

3 Click the Close button to close this dialog box.

4 Connect to the RMX.

If the problem persists, continue with the Procedure 4. 
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Procedure 4: Add the Collaboration Server to the Internet Explorer Trusted Sites 
List

In some cases, local security settings may prevent Internet Explorer from accessing the RMX.

To add the RMX to the Internet Explorer Trusted Sites list:

1 In the Internet Options dialog box, click the Security tab.

The Security tab is displayed.

2 Click the Trusted Sites tab.

3 Click the Sites button.

The Trusted sites dialog is displayed.

4 If the Collaboration Server (RMX) is using Secure Mode:
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a In the Add this website to the zone: field, enter, “https://” followed by the IP address or the DNS 
name of the Collaboration Server (RMX).

b Click the Add button.

c Click the Close button.

5 If the Collaboration Server (RMX) is using Standard Security Mode:

a In the Add this website to the zone: field, enter, “https://” followed by the IP address or the DNS 
name of the Collaboration Server (RMX).

b Click the Add button.

c Clear the Require server verification (https:) for all sites in this zone checkbox.

d Click the Close button.

Procedure 5: Browser Hosting Controls (Optional) 

If the Collaboration Server (RMX) Web Client does not load and run after Procedures 1-4 have been 
performed, the reason may be that .NET Framework 4 or higher is running on the workstation with Managed 
Browser Hosting Controls disabled.

Managed Browser Hosting Controls is an Internet Explorer operating mode required by the 
Collaboration Server (RMX) Web Client. By default, .NET Framework 4 and higher are not enabled to 
support Managed Browser Hosting Controls.

Perform Procedure 5 to:

● Determine whether .NET Framework 4 or higher is running on the workstation.

● Determine whether a 32-bit or 64-bit version of Windows is running on the workstation.

● Enable Managed Browser Hosting Controls if .NET Framework 4 or higher is running on the 
workstation.

To enable Managed Browser Hosting Controls:

1 Determine whether .NET Framework 4 or higher is running on the workstation.

a On the Windows Desktop, click Start.

b In the Start Menu, click Control Panel.

c In the Control Panel, click Programs and Features.

d Inspect the Programs and Features list for the version of Microsoft .NET Framework Client 
Profile that is installed.

2 Determine whether a 32-bit or 64-bit version of Windows is running on the workstation:

a On the Windows Desktop, click Start.

b In the Start Menu, click Computer.

c In the Computer Menu, System properties and inspect the value of the System type field in the 
System section

3 Enable Managed Browser Hosting Controls if .NET Framework 4 or higher is running on the 
workstation.

a Open the Registry.

b Navigate to the Subkey:

 32-bit System: HKEY_LOCAL_MACHINE\SOFTWARE\MICROSOFT\.NETFramework 
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 64-bit System: 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\.NETFramework

c Add the Dword Value: EnableIEHosting

d Set value of EnableIEHosting to 1.

e Close the Registry.

f Close and re-open Internet Explorer.
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